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General Description

The MAX16065 evaluation kit (EV kit) provides a proven 
PCB layout that facilitates evaluation of the MAX16065 
flash-configurable system manager with nonvolatile fault 
memory. The EV kit is a fully assembled and tested 
surface-mount board.

The EV kit includes an on-board USB-to-JTAG and 
SMBus interface, facilitating communications between 
the host PC and the device. Two potentiometers and 
a set of loopback switches make it easy to evaluate 
the sequencing and monitoring functions of the device 
without requiring external power supplies. Headers are 
also provided to facilitate connection to an external 
application circuit.

This EV kit data sheet assumes basic familiarity with the 
device. Refer to the MAX16065/MAX16066 IC data sheet 
for more detailed information.

Features

S USB Interface to Host PC

S Easy-to-Use GUI Software

S On-Board Loopback Switches for Stand-Alone 
Evaluation

S On-Board Potentiometers to Simulate Fault 
Conditions

S Convenient Test Points and Headers for Easy 
Evaluation

S Proven PCB Layout

S Fully Assembled and Tested

 

QTY DESCRIPTION

1 Circuit board assembly: MAX16065EVKIT+

1 USB high-speed A-to-mini B cable, 5ft (1.5m)

DESIGNATION QTY DESCRIPTION

C1, C2, C3, 
C16–C19

7
0.1FF Q10%, 25V X7R ceramic 
capacitors (0603)
TDK C1608X7R1E104K

C4, C13, C15 3
1FF Q10%, 6.3V X5R ceramic 
capacitors (0603)
TDK C1608X5R0J105K

C5–C8 4
18pF Q5%, 50V C0G ceramic 
capacitors (0603)
TDK C1608C0G1H180J

C9, C10 2
2.2FF Q10%, 6.3V X5R ceramic 
capacitors (0603)
TDK C1608X5R0J225K

C11 1
4.7FF Q10%, 6.3V X5R ceramic 
capacitor (0603)
TDK C1608X5R0J475K

C12 1
0.01FF Q10%, 50V X7R ceramic 
capacitor (0603)
TDK C1608X7R1H103K

C14 1
10FF Q20%, 16V X5R ceramic 
capacitor (1206)
TDK C3216X5R1C106M

DESIGNATION QTY DESCRIPTION

C20 1
1FF Q20%, 16V X5R ceramic 
capacitor (0603)
TDK C1608X5R1C105K

D1, D2 2
17.1V zener diodes (3 SOT23)
Central Semi CMPZ5248B+

EXT PWR 1 Red PC-mount test point

F1 1 500mA fuse (2405)

GND 1 Black PC-mount test point

J1 1 6-pin header

J2 1 2-pin header

J3 1 8-pin header

J4 1 3-pin header

LED1–LED13 13 Green LEDs

P1 1 USB mini-B connector

P2 0 Not installed, 8-pin header

P3 0 Not installed, 10-pin header

P4 1
Dual-row, 10-pin protected 
header

P5 1 5-pin header

P6 1 15-pin header

P7 1 12-pin header
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Quick Start

Required Equipment
•	 MAX16065 EV kit

•	 User-supplied PC with a spare USB port

Note: In the following sections, software-related items 
are identified by bolding. Text in bold refers to items 
directly from the EV kit software.

Procedure
The EV kit is fully assembled and tested. Follow the steps 
below to verify board operation:

1) Make sure that jumper J1 (VCC SEL) is in the 5.0V 
position. Also make sure that jumper J2 (CSBIAS) 
is closed, jumper J3 (I2C ADDR) is set to low, and 
jumper J4 (MON1-2 SE/DIFF) is in the 1-2 position 
(single ended).

2) Switches 1 and 2 in switch bank S1 (EN_–MON_ loop-
backs) should be in the off position. All other switches 

in switch banks S1 and S2 should be in the on position. 
All switches in switch banks S3 (EXT SEL), S4 (PC 
SEL), and S5 (PULLUP) should be in the on position. 
Switch bank S6 switches 1 and 8 should be in the on 
position, but all other switches should be off.

3) Connect the EV kit to a PC using the provided USB 
cable. LED4 lights to indicate that the EV kit has 
power.

4) Install and launch the EV kit software.

5) Select I2C from the Connection menu. Make sure that 
Address is 0xA0 in the Address dialog box. Click OK.

6) From the File menu, select Open…

7) Select the “MAX16065 EV Kit Demo.hex” file located 
in the software install folder and click OK. This action 
loads the device registers (but not the flash memory) 
with the demo configuration.

8) Click on the Datalogging tab. Move the enable switch 
(S9) to the on position and note the monitored voltages.

Component List (continued)

Component Suppliers

Note: Indicate that you are using the MAX16065 when contacting these component suppliers.

DESIGNATION QTY DESCRIPTION

P8 1 13-pin header

Q1, Q2 2
n-channel MOSFETs
Fairchild FDC5612

R1, R2, R3 3 4.75kI Q1% resistors (0603)

R4, R5, R6, 
R10, R12

5 221I Q1% resistors (0603)

R7, R13 2 10kI Q1% resistors (0603)

R8, R9 2 33.2I Q1% resistors (0603)

R11 0 Not installed, resistor (2512)

R14 1 11kI Q1% resistor (0805)

R15, R16 2 5kI slide potentiometers, 30mm 

R17, R18, R19 3 10kI Q1% resistors (0805)

RP1 1 8 x 220I Q5% resistor array

RP2 1 8 x 10kI Q5% resistor array

S1–S6 6 8-position DIP switches

S7 1 SPST pushbutton switch

S8, S9 2 SPDT slide switches

DESIGNATION QTY DESCRIPTION

U1 1
Microcontroller (56 TQFN-EP)
Maxim MAXQ2000-RBX+ 

U2 1
USB peripheral controller
(24 TQFN-EP)
Maxim MAX3420EETG+

U3 1
Dual, low-noise, LDO linear 
regulator (6 SOT23)
Maxim MAX8882EUTAQ+ 

U4 1

12-channel flash-configurable 
system manager with nonvolatile 
fault registers (48 TQFN-EP) 
Maxim MAX16065ETM+

Y1 1 12MHz crystal (HCM49)

Y2 1 20MHz crystal (HCM49)

— 4 Shunts

— 1 MAX16065 EVALUATION KIT+

SUPPLIER PHONE WEBSITE

Central Semiconductor 631-435-1110 www.centralsemi.com

Fairchild Semiconductor 888-522-5372 www.fairchildsemi.com

TDK Corp. 847-803-6100 www.component.tdk.com
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Detailed Description of Software

The MAX16065 EV kit software serves two purposes. One 
is to facilitate evaluation of the MAX16065 on the EV kit 
hardware. The second is to provide a convenient way to 
configure a MAX16065/MAX16066 in an application circuit.

Connecting to the EV Kit
Make sure the EV kit is connected to the PC by the USB 
cable. Launch the software and from the Connection 
menu, select I2C or JTAG. When the software is 
unconnected, the device configuration files can be 
edited locally. If you have been editing a local configura-
tion and then connect to an EV kit, the Load Register 
dialog comes up (Figure 1) because the software needs 
to reconcile the local configuration with the contents of 
the part’s registers. Select the Do you want to use the 
values from the part registers and lose your con-
figuration in progress? radio button to overwrite the 
current configuration in memory with the values in the 
physical part’s memory. Select the Do you want to load 
your configuration in progress into the registers of 
the part? (The Flash memory of the part will remain 
unchanged) radio button to take the current configura-
tion and overwrite the registers of the physical part. 
Doing this immediately changes the behavior of the part.

If I2C is selected, the Address dialog comes up. Enter 
the slave address and click OK; the default is 0xA0, but 
other values can be used (see Table 3). JTAG supports 
JTAG chains of more than one device. If more than one 
device is present in the JTAG chain, a selection dialog 
box comes up, which lists devices by JTAG ID.

The software can be used without the EV kit connected 
by selecting Unconnected from the Connection menu.

Input/Output Tab
The Input/Output tab sheet (Figure 2) controls the con-
figuration for the sequencing outputs and monitoring 
inputs of the device.

Input Configuration
Each of the 12 monitoring inputs of the device can 
be configured using the Voltage Monitoring Input 
Configuration group box. There are several settings, each
corresponding to configuration bits in the device registers.

The SE/Diff column can configure channels 2, 4, 6, 8, 
10, and 12 to act as differential inputs. These inputs are 
sensed relative to the previous channel. For example, if 
MON2 is configured as differential, the channel voltage 
measurement is (VMON1 - VMON2). MON1 continues to 
operate as normal.

The MON Range column sets up the input voltage range 
of the monitoring inputs. Select the range that matches 
closest to the desired nominal rail voltage. If the channel 
is not needed, select Not Converted.

Over Voltage, Under Voltage, and Early Warning col-
umns contain the threshold voltages for each of these 
comparisons. Enter the voltage corresponding to each 
threshold voltage. The early warning threshold can act 
either as an undervoltage or overvoltage depending on 
the Early Warning radio button setting.

The OV Critical, UV Critical, and EW Critical columns 
control the critical fault enables for each threshold. If a 
threshold is configured as a critical fault and the voltage 
on the rail trips the comparator during normal operation, 
it causes the sequencer to power down all the outputs 
and triggers a nonvolatile fault log operation. During 
power-up and power-down, all thresholds are consid-
ered critical regardless of these settings.

The Sequence Slot column controls the sequencing 
slot at which the part begins to monitor the voltage. 
Generally the monitoring input should be placed in the 
same slot as the enable output (see the Sequencing 
Output Configuration section). If the input is not moni-
toring a power supply controlled directly by an enable 
output, the Monitoring Only settings can be used. 
Inputs configured this way are monitored only after  
successful sequencing has occurred on either the  
primary sequence or the secondary sequence.

Figure 1. Load Register Dialog
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Current Sense Configuration
The device includes one dedicated current-sense ampli-
fier. Turn it on using the Enable drop-down list. The 
current-sense amplifier monitors two overcurrent thresh-
olds: primary and secondary. The Primary Overcurrent 
setting is controlled by the Gain drop-down list, which 
also sets the gain of the current-sense amplifier. Enter 
a threshold voltage into the Secondary text box to set 
that threshold. If a fault on this threshold should trigger a 
fault power-down and the nonvolatile fault log operation, 
place a check in the Secondary OC Critical checkbox. 
To prevent nuisance triggers on the primary overcurrent 
threshold, configure the Deglitch Delay.

The device also monitors the voltage at the CSP pin. To 
set the voltage range to encompass the maximum VCSP 
voltage, use the CSP Voltage Range drop-down list to 
select the 7V or 14V range.

Sequencing Output (ENOUT) Configuration
The device can control up to 12 power supplies using 
their enable inputs or (on up to 8 of those supplies) 
series-pass n-channel MOSFETS in series with the pow-
er-supply outputs. Set the output type and polarity using 
the Output Type column drop-down lists. The charge-
pump setting is available only on EN_OUT1–EN_OUT8. 
Set the sequencing slot assignment or configure the EN_
OUT_ as a general-purpose input or output (EN_OUT9–
EN_OUT12 only) using the Sequence Slot column drop-
down lists. The sequencer begins at slot 1 and steps 
through each sequencing slot until power-up completes. 
Each output turns on at the appropriate time slot. Set the 
sequence delays on the Detail tab sheet (Figure 3).

The Output column drop-down lists set the state of 
an EN_OUT_ configured as a general-purpose output. 
This setting can be stored in flash memory, setting the 
power-up state of the pin.

Figure 2. Input/Output Tab
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General-Purpose Input/Output Configuration
The device has eight general-purpose input/output pins 
that can be configured for a variety of purposes. 
Configure whether a GPIO should be open-drain or push-
pull using the Output Type column drop-down lists.

The Function column drop-down lists control the 
purpose of each GPIO. See Table 1 for a summary of the 
available options.

The Output column drop-down lists set the state of the 
pin when configured as a GPIO out port. This setting can 
be stored in flash memory, setting the power-up state of 
the pin.

Detail Tab
The Detail tab sheet (Figure 3) contains additional
configuration options for the device relating to fault 
behavior, sequencing, lock bits, the watchdog timer, and 
the reset output.

Sequencing
The Power Down radio buttons in the Sequencing group 
box control whether a normal power-down occurs with 
the power supplies turning off in reverse sequence or 
simultaneously all at once. The slot-delay settings control 
the time delays between each sequencing slot. Click the 
blue underlined timing to change it. Fault Timer controls 
the period of time allowed for a power supply to fall within 
its power-good thresholds from when it is turned on.

During a fault condition, the device can either shut off or 
try to sequence again, depending on the Fault Behavior 
setting. Select Latchoff from the drop-down list to have 

the device shut down and not attempt to restart power 
sequencing. Select Retry always and select a delay 
period to have the device attempt sequencing again after 
the delay occurs. Select Retry 1 time or Retry 3 times to 
limit the number of retry attempts.

When a monitored voltage falls outside one of the pro-
grammable thresholds, the device’s internal ADC repeats 
several conversions on the same channel. To trigger 
a fault condition, the voltage must remain outside the 
threshold for a number of ADC conversions programmed 
by the Deglitch setting. Allowable options are 2, 4, 8, or 
16 cycles.

The Final Slot drop-down list selects the last slot 
of the primary sequence and sets the split between 
the primary and secondary sequencer. Refer to the 
MAX16065/MAX16066 IC data sheet for more informa-
tion. Current sequence state displays the current state 
of the sequencer. Failed slot in secondary sequence 
displays which slot in the secondary sequence failed, if 
such a failure occurred. Both values are only displayed 
when connected to a physical device since they are 
contained in status registers that have no corresponding 
flash memory location.

If the Software enable 1 checkbox is checked and 
the ENABLE switch on the EV kit is turned on, then the 
sequencer attempts to power up. If the Software enable 
2 checkbox is checked and the ENABLE2 switch (if the 
GPIO is configured accordingly) on the EV kit is turned 
on, then the sequencer turns on supplies in the second-
ary sequence. To use the ENABLE2 switch, the switch 

Table 1. GPIO Configuration Settings
NAME AVAILABLE ON GPIO DESCRIPTION

GPIO In Port GPIO1–GPIO8 General-purpose input.

GPIO Out Port GPIO1–GPIO8
General-purpose output (open-drain or push-pull). The output state is controlled 
by the Output column.

Fault2 GPIO1–GPIO8 Configurable fault outputs (open-drain or push-pull). These are configured with 
the Fault Pin Dependencies control.Fault1 GPIO1, 2, 4–7

FAULTPU GPIO3, 8 Power-up fault. Asserts if a tracking fault occurs during power-up.

Any_Fault GPIO1, 3, 4, 5, 7 Fault output (open-drain or push-pull). Asserts low during any fault condition.

RESET2 GPIO2, 6, 8 Secondary sequence reset output. 

OVERC GPIO1–GPIO8
Primary overcurrent comparator output. Asserts low when the voltage between 
CSP and CSM exceeds the primary overcurrent threshold.

Manual Reset GPIO1, 3, 5, 7
Manual reset input. When asserted low externally, this triggers a reset pulse on 
RESET.

WDO GPIO2, 4, 6, 8 Watchdog output. Dedicated watchdog timer output.

WDI GPIO1 Watchdog input. Input to the internal watchdog timer.

EXTFAULT GPIO4, 8 External fault input/output.

EN2 GPIO5, 7 Secondary sequence-enable input.

MarginB GPIO6
Margining control input. When pulled low externally, this disables threshold 
monitoring so margining can be performed.
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must be connected to a GPIO input using the FEATURE 
(S6) switch bank, and that GPIO must be configured as 
EN2 (see Table 1 and the Hardware Enables section).

The Margin mode (disables monitoring) checkbox 
can temporarily disable voltage monitoring so that the 
connected power supplies can be margined or trimmed 
outside of their normal voltage limits, without triggering 
any faults.

Device
The Device group box contains some general device 
parameters. Customer Version is a single general-
purpose register that can be used as a loopback for 
testing purposes, or to store a configuration version num-
ber. Device Revision Code displays the revision of the 
MAX16065 silicon. The Packet Error Checking Enabled 
checkbox controls whether the device expects and veri-
fies the checksum attached to SMBus traffic. If this option 

is checked, the EV kit software needs to be configured 
so the SMBus host driver generates the checksum byte.
Select Tools → PEC Enabled. If this is not done, the EV 
kit SMBus host can lose contact with the device. Toggle 
Tools → PEC Enabled to restore the connection.

The SMB alert pin configuration drop-down list sets 
the assignment of the SMBus ALERT# signal. A GPIO 
pin configured as FAULT1, FAULT2, or Any_Fault can be 
configured to act as the SMBus ALERT# (see Table 1).

The Send ARA button is available only when connected 
using SMBus mode. When the SMBus ALERT# signal is 
asserted, press this button to send the alert response 
address (ARA) command on the SMBus to determine the 
slave address of the device causing the SMBus interrupt. 
On the device, the ALERT# signal remains asserted until 
the ARA is received.

Figure 3. Detail Tab
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Lock Bits
Checkboxes for several lock bits control access to differ-
ent parts of the device’s memory. Configuration register 
file lock prevents access to the volatile configuration reg-
isters. Configuration flash lock prevents access to the 
nonvolatile flash memory. Flash fault register file lock 
prevents the contents of the nonvolatile fault log memory 
from being overwritten. This lock is set automatically 
after a fault log operation occurs. User flash lock pre-
vents access to the user flash (addresses 300h to 3FFh, 
excluding 3A0h to 3AFh).

RESET Pin Configuration
The RESET output can be configured to depend on a 
number of different conditions. Assert pin on controls 
whether the output depends on overvoltage, undervolt-
age, early warning, or both undervoltage and overvolt-
age conditions. Check the appropriate monitoring inputs 
checkbox under Dependent on to set which thresholds 
the RESET output depends on. Note that the RESET out-
put always depends on the primary sequence and only 
deasserts when the primary sequence is completed. 
If a fault occurs in any MON_ input configured as a 
critical fault, the sequencer turns off the enable outputs 
assigned to the primary sequence and asserts RESET 
regardless of the settings in this section. Select the reset 
timeout using the Timeout drop-down list, and configure 
the output as push-pull or open drain and active high or 
active low by selecting the appropriate radio buttons.

Some controls do not match up with flash memory con-
figuration registers and can only be accessed when the 
EV kit is connected to a part. These include the Assert 
RESET Output checkbox, the Current Reset Pin State 
indicator, and the reset reason indicators. To manually 
cause RESET to assert, check the Assert RESET Output 
checkbox. The Current Reset Pin State indicator shows 
the current state of the RESET output. The Reset was 
caused by Watchdog timer and Reset was caused by 
Enable Pin going low indicators show the reason for the 
last reset pulse. Clear these indicators using the adjacent 
reset buttons.

Fault Pin Dependencies
Many GPIO pins can be configured as Fault1 and Fault2 
outputs. Each output can be configured to depend on 
overvoltage, undervoltage, or early warning conditions 
on one or more input channels. When a selected channel 
voltage exceeds the voltage of the selected threshold, the 
output asserts. The outputs can be configured as active 
high or active low. Check the boxes under the appropri-
ate row and column to enable or disable each setting.

Fault Setup
The Fault Control drop-down list controls the data that 
is saved during a nonvolatile fault log operation. It can 
save the ADC conversion results, the fault flags, or both.

If EXTFAULT (If enabled) is checked, then an external 
assertion of the EXTFAULT input causes a nonvolatile 
fault log operation. If Enter fault state when EXTFAULT 
asserted externally is checked, then an external asser-
tion of the EXTFAULT input causes the sequencer to 
turn off all the inputs and enter fault mode. If the EV kit 
is connected through SMBus or JTAG, then the fault 
flag indicators are visible. They indicate the fault status 
of each input, the current-sense amplifier, the SMBus 
ALERT signal, and the EXTFAULT input. Clear the flags 
by pressing the Clear All button.

To manually trigger a nonvolatile fault log operation, 
press the Trigger Fault button.

Watchdog Timer
The internal watchdog timer can be configured in this 
group box. Click on the blue link next to Timeout to 
change the watchdog timeout period and enable the 
watchdog timer.

If the watchdog timeout period needs to be extended 
during initial startup to allow for an external microproces-
sor to complete a boot-up sequence, specify the startup 
timeout with the blue link next to Startup delay.

Normally the watchdog timer simply asserts WDO, but 
if desired, the watchdog timer can also assert RESET. 
Check the Reset output enable checkbox to enable this 
behavior.

If Dependent Mode is set, the watchdog timer turns on 
after power sequencing is complete and RESET deas-
serts. If Independent Mode is set, the watchdog timer 
turns on immediately and remains on regardless of the 
power sequencing state.

Check the WDI toggle checkbox to manually clear the 
watchdog timer and prevent a watchdog timeout.

Datalogging Tab
The Datalogging tab sheet (Figure 4) is only visible when 
connected to an EV kit. Each of the monitored voltages 
and their thresholds can be observed on this tab, along 
with the voltage measured across the current-sense 
amplifier terminals. To see all the voltage inputs, use the 
scrollbar on the right side of the window.

Thresholds can be modified by either clicking on the 
blue links or manually dragging the dotted line on the 
waveform display. The fault mode and the input voltage 
ranges can also be modified, although all the configura-
tion options available on this tab are duplicated from the 
Input/Output tab and modify the same registers.

Fault Tab
Observe the contents of the nonvolatile fault registers 
using the Fault tab sheet (Figure 5). This tab is available 
only when connected to an EV kit. Each stored channel 
voltage is listed as a voltage calculated automatically 
using the input range selection.
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The failed line is marked using a red dot. If the fault 
occurred during sequencing, the Sequencer State row 
indicates the state in which the fault occurred, which can 
be a sequencer slot.

Press the Clear fault register button to reset the con-
tents of the nonvolatile fault registers. If the lock bits are 
set, a dialog box allows you to clear them.

Register Tab
The Register tab sheet (Figure 6) provides direct access 
to the registers and flash of the device.

Configuration Registers Subtab
The Configuration Registers subtab sheet (Figure 6) 
provides low-level access to the configuration registers 
of the device when connected using SMBus or JTAG. 
Individual registers can be edited by clicking on the 
appropriate cell. To write the current configuration to 
flash, press the Write registers to device Flash button. 
This does the same thing as selecting Save Registers to 
Flash from the Program menu bar.

Configuration Flash Subtab
The Configuration Flash subtab sheet (Figure 7) pro-
vides low-level access to the flash memory of the device. 

Before editing any flash registers, read the contents 
of the flash memory into the software by pressing the 
Read Configuration Flash button. After editing flash 
registers by clicking on the appropriate cells, write the 
flash memory back out to the part by pressing the Save 
Configuration Flash button. To clear the device’s flash 
memory, press the Erase Configuration Flash button.

Non-Volatile Fault Flash Subtab
The Non-Volatile Fault Flash subtab sheet (Figure 8) 
provides read-only low-level access to the nonvolatile 
flash fault log memory.

User Flash Subtab
User flash memory can be accessed from the User 
Flash subtab sheet (Figure 9). To read the user flash 
memory of the device, press the Read User Flash 
button. Click on any cell to edit the contents of the  
memory. When finished, press the Save to User Flash 
button to write the changes back out to the flash memory. 
To load a hex file into the user flash, press the Load 
User Flash from HEX File button. To save the contents 
of the user flash to a hex file, press the Save User Flash 
to HEX File button. The user flash is not stored with the 
current configuration file and must be stored separately 
using the buttons on this tab.

Figure 4. Datalogging Tab
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Figure 6. Configuration Registers Subtab

Figure 5. Fault Tab
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Figure 7. Configuration Flash Subtab

Figure 8. Non-Volatile Fault Flash Subtab
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Figure 9. User Flash Subtab

Menu Reference
File Menu

New clears the contents of the configuration registers. 
If connected to an EV kit, this writes zeros into all the 
configuration registers while preserving the contents of 
the flash memory.

Save/Save As… saves the current configuration to a 
standard Intel hex file.

Open… loads the configuration from an Intel hex file.

Export to SVF File… exports the current configuration to 
an SVF file, which is the standard format used by JTAG 
device programmers for production programming. The 
EV kit software cannot load SVF files, so be sure to save 
your work in hex format first.

Exit quits the program.

Connection Menu
I2C opens a connection to the device on the EV kit using 
the I2C/SMBus protocol. You must specify the slave 
address in order to connect. See Table 3 for a list of 
possible slave addresses. If you have been editing a 
local configuration and then connect to an EV kit, the 
Load Register dialog comes up (Figure 1) because the 
software needs to reconcile the local configuration with 
the contents of the part’s registers. Select the Do you 
want to use the values from the part registers and 

lose your configuration in progress? radio button to 
overwrite the current configuration in memory with the 
values in the physical part’s memory. Select the Do you 
want to load your configuration in progress into the 
registers of the part? (The Flash memory of the part 
will remain unchanged) radio button to take the current 
configuration and overwrite the registers of the physical 
part. Doing this immediately changes the behavior of the 
part.

JTAG connects to the device on the EV kit using the 
JTAG protocol. The Load Register dialog may come up, 
as previously described.

Unconnected disconnects from the EV kit. The software 
can be used to create, edit, and view hex files locally 
without a connected EV kit.

Program Menu
This menu item is available when connected to an EV kit 
and provides commands to access the flash memory of 
the device.

Save Registers to Flash takes the contents of the con-
figuration registers and writes it to the flash memory.

Load Registers From Flash (Reboot) takes the con-
tents of the flash memory and writes it into the configura-
tion registers.
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Load HEX File to Flash… takes the contents of a hex 
file and writes it directly to the flash memory. This com-
mand is useful for batch programming a device on a 
target board connected to the EV kit through the JTAG or 
SMBus connectors.

Interface Menu
Block Read Enabled controls whether the SMBus host 
interface uses block read commands when polling the 
device.

PEC Enabled enables packet error check capability for 
the SMBus host interface. The device must be configured 
for PEC capability using the Packet Error Checking 
Enabled checkbox on the Detail tab sheet (Figure 3).

Read All Registers causes the host interface to read all 
the device registers into the PC.

Autopoll turns register polling on and off. When polling 
is on, the controls in all tabs are periodically refreshed 
from the physical registers. If polling is off, register 
contents can be read from the device by selecting 
Read All Registers.

Help Menu
About launches the About dialog, which displays the 
software version. The firmware version is displayed on 
the status bar at the bottom of the main window.

Detailed Description of Hardware

The MAX16065 monitors and sequences up to twelve 
power supplies. Eight configurable input/outputs indicate 
fault status information and control some functions of the 
IC. Figure 10 provides an overview of the major features 
of the EV kit PCB.

Figure 10. Evaluation Kit PCB Diagram
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Figure 11. Connecting the EV Kit to an External Application Board Using the JTAG Interface

USB Host Interface
The EV kit includes a built-in USB-to-JTAG/SMBus host 
interface. The host interface uses the MAX3420 USB 
peripheral controller along with a MAXQ2000 microcon-
troller to communicate with the host PC and generate 
the SMBus/JTAG bus signals. Three indicators (LED1, 
LED2, and LED3) provide status information of the host 
interface. LED1 lights during EEPROM write operations, 
LED2 lights during SMBus or JTAG bus activity, and 
LED3 lights when the software is connected to the EV kit.

To facilitate prototype development and programming, 
the host interface can be used to interface with a 
MAX16065 on another board by turning off switches 1–7 
in switch bank S3 (EXT SEL). This disconnects the on-
board device from the SMBus and JTAG buses. Connect 

to the other board using P4 and P5. The pinout of each 
connector is shown in Tables 4 and 5. Note that the 
SMBus pullup resistors (R1, R2, and R3) are located on 
the EV kit host interface.

The on-board device can be connected to an external 
SMBus or JTAG interface by turning switch bank S4 (PC 
SEL) switches 1–7 off while keeping switch bank S3 (EXT 
SEL) switches 1–7 on. Connect the external interface 
to P4 for JTAG or P5 for SMBus. The device can be 
completely disconnected from the on-board USB host 
interface by using this technique while providing external 
power to EXT PWR (J1 must be in the EXT position).

Each interface can be disconnected or connected  
separately. SMBus uses switches 1, 2, and 3 on both S3 
and S4 and JTAG uses switches 4–7 on both S3 and S4.
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Power Source
The device can be powered from one of three possible 
power supplies, controlled by jumper J1. To power directly 
from the USB 5V supply, place the jumper in the 5V  
position. When the jumper is in the EXT position, the 
device can be powered from an external power supply 
connected to the EXT PWR test point. Do not supply a 
voltage higher than 14V or less than 4.5V. To power the 
device from 3.3V, short ABP and DBP with VCC.

SMBus Address
The device has both a JTAG interface and SMBus serial 
interface. The SMBus slave address of the on-board 
device can be set using J3 according to Table 3. Note 
that this externally configured SMBus slave address can 
be overridden by device register r8Bh.

On-Board MOSFETs and Potentiometers
To facilitate evaluation of the monitoring and control 
functions of the device, two potentiometers provide 
adjustable voltages. The potentiometers are connect-
ed to the device in series with n-channel MOSFETs 
that are controlled by two sequencing outputs of the 
device (Figure 13). This combination imitates two power  
supplies. Fault conditions can be simulated simply by 
adjusting the potentiometer according to the scale on the 
PCB silkscreen.

To use the potentiometer assigned to MON1, make sure 
switch 1 in switch bank S1 is turned off (no loopback) and 
make sure switches 5 and 6 in switch bank S2 are turned 
on. This connects the potentiometer circuit to the device. 
For the MON2 potentiometer, turn off switch 2 in switch 
bank S1 and turn on switches 7 and 8 in switch bank S2.

Single-Ended Mode
In single-ended mode (J4 is in the 1-2 position) the 
device monitors the voltages of each potentiometer 
separately. In the Input/Output tab (Figure 2), assign 
thresholds and sequencing slots to MON1 and MON2. 

Figure 12. Connecting the EV Kit to an External Application Board Using the SMBus Interface

Figure 13. On-Board Series-Pass MOSFETs (Simplified Circuit)
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Set EN_OUT1 and EN_OUT2 to the Charge Pump con-
figurations, and assign them sequencing slots so that 
EN_OUT1 is in the same slot as MON1 and EN_OUT2 is 
in the same slot as MON2.

Differential Mode
The potentiometers can be used to evaluate the differ-
ential input function of the device. In the Input/Output 
tab, set MON2 to Differential and assign thresholds 
and a sequencing slot. Set EN_OUT1 to the same slot. 
Set jumper J4 (MON1-2 SE/DIFF) on the EV kit to the 2-3 
position. This allows both potentiometers to be switched 
by the EN_OUT1 output. Control the voltage on MON1 
using POT1 and the voltage on MON2 using POT2. The 
device monitors the voltage difference of POT1 - POT2.

Monitoring Inputs and Enable Outputs
Each of the MON_ inputs and EN_OUT_ outputs can be 
accessed through headers P8 (EN_OUT) and P6 (MON).

Switch banks S1 and S2 allow EN_OUT1–EN_OUT12 
to be connected to MON1–MON12 to help evaluate the 
device’s sequencing feature. Configure the EN_OUT_s 
for active-high push-pull, and the voltage thresholds of 
the MON_s to correspond with the output logic levels.

Precision Current Sense
The EV kit provides connections to the precision  
current-sense amplifier of the device. The positive input 
terminal (CSP) needs a bias voltage of 3V to 14V for 
proper operation. To use the VCC voltage selected by 
J1, short jumper J2. To provide an external bias voltage,  
disconnect J2 and connect the bias supply to pin 1 of 
header P6 (MON).

A high-accuracy voltage source can be connected 
between CSP and CSM (pins 1 and 2 of header P6) to 
evaluate the monitoring and fault functions of the current-
sense amplifier. Alternatively, a current-sense resistor 
can be soldered into position R11 and a test current 
directed through CSP to CSM.

The voltage of CSP can be monitored using the EV kit 
software, although this monitoring function does not have 
fault thresholds and cannot trigger a fault.

General-Purpose Inputs and Outputs
Each GPIO has a separate indicator LED and pullup 
resistor, and each signal is brought out to a pin on P7. 
An LED lights to indicate that the associated output has 
gone to the logic-low state. The LEDs can be disabled 
by turning off switch 8 in switch bank S4 (PC SEL). The  
pullup resistors are individually switched by S5 (see 
Table 4 for the assignments of each switch in the switch 
bank). To use an external pullup voltage, set switch 8 of 
switch bank S3 (EXT SEL) in the off position and connect 

the voltage source to the VPU pin of P7. This pullup volt-
age is also used for the reset output’s pullup resistor.

Reset Output
LED5 displays the status of the reset output. When the 
reset output is low, the LED lights up. If switch 8 of switch 
bank S6 (FEATURE) is in the on position, a 10kI pullup 
resistor is connected to the reset output. Power to the 
LED is controlled by switch 8 of switch bank S4 (PC SEL), 
just as with the GPIO.

Hardware Enables
The device has an analog EN connection that can be 
used to trigger power-up or power-down sequencing. An 
on-board resistive divider formed by R14 and R17 sets 
the falling threshold to 2.835V on VCC; the threshold can 
be modified by changing R14 and R17 according to the 
following formulas:

 = ⋅ + 
 

VCC_TH_RISING
R14

V 1.4 1
R17

 = ⋅ + 
 

VCC_TH_FALLING
R14

V 1.350 1
R17

EN can be manually controlled using the hardware 
enable switch (S9). Set S9 to the off position to pull EN to 
0V, and set S9 to the on position to allow EN to respond 
to the VCC voltage.

To drive EN externally and disable the ENABLE switch, 
turn off switch 1 in switch bank S6 and connect the  
external circuit to pin 1 of header P7 (GPIO).

Secondary Enable
For controlling the secondary sequence group, GPIO5 
and GPIO7 can be configured as the secondary sequence 
enable (EN2) and wired to the ENABLE2 switch on the EV 
kit. After selecting the GPIO in the EV kit software’s Input/
Output tab (Figure 2), close switch 2 (if GPIO5 is to be 
used) or 3 (if GPIO7 is to be used) in switch bank S6.

Manual Reset Button
A manual reset button (S7) is provided on the EV kit. It 
can be connected to GPIO1, GPIO3, GPIO5, or GPIO7. 
Close switch 4, 5, 6, or 7 in switch bank S6 to connect 
the manual reset button to a GPIO configured as the 
manual reset input. Configure the GPIOs using the EV kit 
software’s Input/Output tab.

The manual reset button can also be used to evaluate the 
watchdog timer by connecting it to GPIO1 and configur-
ing GPIO1 as the watchdog input (WDI). Push the button 
to pulse WDI and clear the watchdog timer. For best 
results, use long watchdog timeout periods.
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Table 2. Jumper Functions (J1, J2, J4, S1–S6)

Table 3. Jumper Function (J3) Table 5. JTAG Connector Pinout (P4)

Table 4. SMBus Connector Pinout (P5)

*Default position.

*Default position.
X = Don’t care, R = Read/write select bit.

Jumper Function Tables

JUMPER POSITION FUNCTION

J1

5V Device powered from the USB voltage.

3.3V Device powered from on-board 3.3V LDO.

EXT Device powered externally.

J2
Open Biased externally (3V to 14V range).

Closed* Biased to VCC.

J4
1-2 Single-ended mode.

2-3 Differential mode (POT1 and POT2 both controlled by EN_OUT1).

S1 1-8 Loopback control.

S2

1-4 Loopback control.

5-6 Connects POT1 to MON1/EN_OUT1.

7-8 Connects POT2 to MON2/EN_OUT2.

S3

1-3 SMBus connects to part.

4-7 JTAG connects to part.

8 GPIO pulled up to 3.3V when on.

S4

1-3 SMBus connects to host interface.

4-7 JTAG connects to host interface.

8 GPIO LED indicators on.

S5 1-8 Connects individual pullup resistors to GPIO.

S6

1 Connects ENABLE switch to EN pin.

2-3 Connects secondary enable (EN2) switch to either GPIO5 or GPIO7.

4-7 Connects manual reset switch (S7) to GPIO1, 3, 5, or 7.

8 Connects pullup resistor to RESET output.

SHUNT POSITION SMBus SLAVE ADDRESS

Low* 1010 00XR (A0h)

High 1010 01XR (A4h)

SCL 1010 10XR (A8h)

SDA 1010 11XR (ACh)

PIN FUNCTION

1 TCK

2 Ground

3 TDO

4 3.3V (output only)

5 TMS

6 —

7 — (key)

8 —

9 TDI

10 Ground
PIN FUNCTION

1 3.3V (output only)

2 SDA

3 Ground

4 SCL

5 SMBALERT# (not used by the device)



 ________________________________________________________________  Maxim Integrated Products  17

MAX16065 Evaluation Kit
Evaluates: MAX16065

Figure 14. MAX16065EV Kit Schematic
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Figure 15. MAX16065EV Kit Schematic—USB Interface
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Figure 16. MAX16065EV Kit Component Placement Guide—Component Side

Figure 17. MAX16065EV Kit PCB Layout—Component Side
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Figure 18. MAX16065EV Kit PCB Layout—Solder Side
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Ordering Information

+Denotes lead(Pb)-free and RoHS compliant.

PART TYPE

MAX16065EVKIT+ EV Kit
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